MICROSOFT WORD 2002 (Xp)
Prof. : Edgar Lopategui Corsino

INTRODUCCIÓN

Microsoft (MS) Word representa uno de los programas (aplicación o “software” en Inglés) más útiles para un maestro.  Este programa es uno de los procesadores de palabras más usados en la actualidad.  Entiéndase como procesador de palabras (o de texto) aquella aplicación o programa empleado para crear, configurar/manipular caracteres, textos y archivos que se conocen como documentos.  Por el otro lado, cuando hablamos de texto nos referimos a cualquier elemento o secuencia de caracteres alfanuméricos (letras y números) y caracteres especiales que se encuentran dentro de un archivo de un documento.  MS Word es un procesador de texto con herramientas de producción y edición muy poderosas que compite actualmente con Word Perfect (Corel Corporation, dentro de paquete de Corel Perfect Offfice) y Lotus Word Pro (Lotus, dentro de paquete de Lotus Smartsuite), Claris Works, entre otros.


MS Word forma parte del Grupo de Office Xp (2002), lo que permite integrar documentos, cálculos, gráficas, itinerarios y bases de datos entre los programas que componen este grupo:  Word, Excel, PowerPoint, Outlook y Access, entre otros (dependiendo del tipo de paquete comprado).
La función fundamental del programa de MS Word es la de crear, editar, corregir, formatear (aplicar formato o cambiar apariencia), eliminar, copiar, pegar e imprimir texto; incluyendo la distribuir documentos electrónicos.  Esta función se conoce como la de procesamiento de palabras (o texto).  Todo procesador de palabras permite generar documentos electrónicos, modificar o editar el texto creado antes de imprimirlo, controlar y manejar un documento y distribuir documentos (vía medios de almacenamientos removibles como un CD-ROM, por el correo electrónico [email] o publicarlo en el Web).  El texto se entra en el programa mediante el uso del teclado.  Durante este proceso, la información se almacena en la memoria temporera de la computadora (RAM) y se exhibe en la pantalla del usuario.  Al texto se le podrá aplicar un Formato (“Format”), es decir, cambiar sus características (del texto), tales como estilo, tipo, tamaño, color entre otras.  Luego se puede guardar en su unidad de almacenamiento (Ej., disco duro, disco flexible o "Floppy", USB Flash Drive, entre otros).

Para propósitos de este libro, emplearemos el carácter  >  para indicar la dirección de los pasos a seguir al ejecutar un comando o acción en Word:  Por ejemplo,  al describir la manera de abrir un archivo de Word, podemos abreviar este procedimiento como sigue:  File > Open (es decir, dirigirse al menú de File localizado en la barra de menú y luego seleccionar Open del Submenú).

INTERFAZ DE WORD - COMPONENTES DE LA PANTALLA DE UN DOCUMENTO DE MICROSOFT WORD


Las partes de la pantalla principal del programa de MS Word incluyen las Barras (de título, de menú, de herramientas y de formato), las reglas, el área de escribir, las barras de desplazamiento, la barra de estado, el guión, entre otras (véase Figuras 1-1, 1-2 y 1-3).
Barra de Título (“Titlebar”)
Representa la primera barra.  Se encuentra localizada horizontalmente en la parte superior de la ventana.  La barra de título muestra el nombre de la aplicación (Microsoft Word) y el nombre del documento actual (el nombre que le hemos dado al archivo guardado).  El dibujo de la W a la izquierda abre un menú de control que permite salir del programa entre otras opciones.  Los cuadros a la extrema derecha permiten cambiar el tamaño total de la ventana del programa.  Esta barra es común en todas las aplicaciones de Windows.
Barra de Menú (“Menu Bar”)

El menú de barra se localiza debajo de la barra de título, la cual presenta el menú de "Word".  Cada menú de "Word" contiene una lista de comandos empleados para acceder, almacenar, imprimir, formatear, entre otras funciones, la información en el documento.  Contiene los Comandos  principales: File, Edit, View, Insert, Format, Tools, Table, Window y Help.  Muchos de estos comandos poseen un retrato al lado de ellos para ayudar a rápidamente identificarlos.

Representan Menues de los cuales se pueden seleccionar comandos.  La barra de menú contiene nueve menús de comandos que son útiles para formatear y editar documentos.  Cada uno de estos comando tienen un Submenú que permite realizar funciones específicas.  Al colocar el ratón sobre el Comando aparece el Submenú.  Cuando se aplica un clic sobre la barra de Menú, el Submenú  (menú vertical o de cascada [“pull down”]) aparecerá, ilustrando las funciones/comandos que están disponibles.  También puede ver cada uno de los Submenú oprimiendo la letra  que está subrayada.  A continuación algunas cosas que se deben saber:

· Ellipsis (…):  que sigue a un comando:  Una caja de diálogo aparecerá

· Flecha:  Indica que existen comandos adicionales.

· Negritas:  El comando esta disponible para su uso.

· Comando menguado (“Dimmed”):  El comando no esta disponible para su uso.

· Letra subrayada:  Presionado la tecla que esta subrayada activa un comando, al igual que aplicando un clic con el ratón sobre ducho comando.

· Flecha al final del menú vertical:  Indica que existen comandos adicionales.
Barra de Herramientas

Incluye la Barra de Herramientas Estándar y la Barra de Herramientas de Formatear.:  Representan botones/íconos que proveen acceso a comandos comunes.  De esta barra se pueden realizar comandos utilizando estos ícono o botones.  Los íconos o botones son gráficas las cuales activan una orden o acción para que los Comandos se realicen rápidamente con menos movimiento, de esta forma se ahorra tiempo.  Por ejemplo, si se quiere abrir un documento me voy a través de los comandos: File, Open, que son dos pasos.  Por el otro lado, si se emplea la barra de herramientas, simplemente se oprime el icono que lo representa, que es solo un paso.   Ambos me llevan a la misma ventana.  El nombre de cada botón se muestra cuando se apunta sobre este con el puntero del ratón.

Barra de Herramientas Estándar

Debajo del menú de barra se encuentra la barra de herramientas estándar.  Esta compuesta de botones que representan los comandos más utilizados del menú de barra. Además, el uso de estos botones permiten ejecutar tareas más rápidas, al compararse con el menú principal de barra.  Cada botón tiene una ilustración al frente que ayuda a recordar su función.

Barra de Herramientas de Formateo (o Formato)
La barra de herramientas de formateo (o formato) se localiza inmediatamente debajo de la barra de herramientas estándar.  Esta barra nos dice el tipo de letra, el tamaño de la letra, el estilo, el formato del documento, entre otros.
El Botón de Show/Hide.  ([image: image1.bmp])Tu puedes saber exactamente donde están tus [Enters]  al decirle a Word que lo Muestre.  Cuando usted selecciones esta opción, Word mostrará dónde están ubicados todos tus espacios y [Enters] en el texto.  Además, se muestran todos los caracteres que no se imprimirán, tales como marcadores de párrafos ([image: image2.jpg]


) y espacios([image: image3.bmp]).  Al crear un documento es de ayuda emplear estos caracteres, puesto que facilita el cotejo de documento.

Reglas

La Regla (“Ruler”) nos muestra los márgenes y la indentación o sangría.  Debajo de la barra de herramientas de formateo, se encuentra la regla horizontal. Esta Regla (“Ruler”) se utiliza para establecer las paradas de los "tabs", identar (sangrar) los parrafos, ajustar el ancho de las columnas, y cambiar los márgenes de los párrafos.  Existe otra regla llamada la regla vertical.  Esta regla aparece en el margen izquierdo de la ventana cuando se ejecutan ciertas tareas particulares.

Para cambiar cómo se muestra la Regla, seleccione “Ruler” desde el menú de “View”  En esta regla se encuentran los marcadores de indentar.   Estos marcadores se emplean para ajustar la primera línea y los márgenes izquierdo y derechos de los párrafos.  El primer triángulo hacia abajo indica el marcador de indentar de la primera línea.  El segundo triángulo hacia arriba indica el marcador de indentar izquierdo.  El segmento final representa el marcador de indentar combinado (mueve ambas líneas, es decir, los marcadores de intentar izquierdo y la primera línea a la vez).

Íconos de Control del Menú

Estos se encuentran en la esquina superior izquierda de una ventana.  Los íconos de control del menú controlan el tamaño y posición de la aplicación y documentos de Windows.

Ventana del Documento

Representa un área bordeada en la pantalla donde el usuario escribe o edita un documento.  La ventana del documento permite que el usuario pueda observar la porción del documento en la pantalla de su monitor.

Área de Texto (“Typing Area”)
Es donde vamos a escribir nuestro texto.  Dentro de esta  área se encuentra el Punto de Inserción (“Insertion Point”), que es un palito vertical, el cual vamos a utilizar donde vamos a escribir.  Conforme el usuario escriba o inserte imágenes, el texto y las gráficas aparecerán en el área de texto.

Cursores

Cursor de: Viga I (“I-beam”)
Se convierte en una flecha cuando se ubica fuera de los bordes.  Se encuentra bajo el control del ratón y te permite, al aplicar un clic con el botón izquierdo del ratón, colocar el cursor del punto de inserción en cualquier lugar deseado en el texto de tu documento.

Puntero del Ratón.  El puntero del ratón cambia de aspecto según sea la tarea que se encuentra llevando a cabo.  Por ejemplo, el puntero del ratón se convierte en una viga-I cuando se encuentra en el área de texto.

Cursor de: Punto de Inserción

No esta directamente controlado por el ratón.  El punto de inserción representa una barra vertical centelleando (aparece y desaparece continuamente) que indica dónde el texto será insertado conforme se escriba con el teclado (indica dónde los caracteres exactamente aparecerán en el texto cuando cuado se presionen las teclas).  Mientras el usuario entre el texto, el punto de inserción se mueve hacia la derecha y, cuando se llegue al final de la línea, se mueve hacia abajo (se ubica en la próxima línea).  Se ubica usando el curso de viga I y con un clic del ratón.  El usuario también puede insertar gráficas en el lugar del punto de inserción.

Marca del Final

La marca del final indica el final de su documento.  Cada vez que usted comienza una nueva línea, según usted escribe la marca del final se mueve hacia abajo.

Barra de Desplazamiento (“Scroll Bar”)
Se encuentran a lado derecho y abajo del Área de Texto.  Permite desplazar horizontal y verticalmente las partes del documento en la ventana del documento, es decir, nos ayudan a movernos dentro del documento, ya sea hacia arriba, hacia abajo, o a los lados.  La barra de desplazamiento vertical se encuentra en el borde derecho de la ventana del documento.  Por otro lado, la barra de desplazamiento horizontal se localiza en la porción inferior del documento.  En ambas barras de desplazamiento, el cuadro de desplazamiento indica la ubicación actual del documento. 

En la esquina inferior izquierda de las barras de desplazamiento, el programa de "Word" provee tres botones que se emplean para cambiar la vista o presentación (modo de ver) su documento.  Para desplazar el documento horizontal o verticalmente, basta con que haga un clic sobre las barras o las flechas de desplazamiento, o que arrastre el cuadro de desplazamiento.

Barra de Estado (“Status Bar”)
Este nos indica la localización en que nos encontramos dentro del documento, en qué página estamos en el documento, la hora y la fecha.  La barra de estado se encuentra en la parte inferior de la pantalla.  Desde la izquierda hasta la derecha, esta barra muestra la siguiente información de la página; el número de la página, el número de sección, la página visible en la ventana del documento seguido del número total de páginas, la posición del punto de inserción en pulgadas desde el tope de la página, el número de línea y el número de la columna del punto de inserción, y varios indicadores de estado.

Icónos de Guión, Maximizar y Reducir la Ventana y la equis (X)


Se encuentran en la esquina superior-derecha de la pantalla (a la derecha de la bara de título, de hecho se encuentra dentro de la barra de título).

Guión (-)


Se utiliza para minimizar el documento Programa y se conserva en la Barra de Tarea.  Esto con el propósito de utilizarlo más adelante.


Maximizar y Reducir la Ventana


Se utiliza para trabajar con más de un documento a la vez.

Equis (X)


Se utiliza para salir del programa.

ACTIVANDO/INICIANDO EL PROGRAMA DE WORD

Para comenzar/acceder el programa de “Word”, Windows debe estar corriendo.   Ejecute los siguientes pasos para comenzar a utilizar a Word, o pregúntele a su instructor si tiene dudas de cómo ir a Word desde su sistema.  Siga los pasos que se describen a continuación:

1. Active su máquina (enciende tu computadora).  Se observará la pantalla de bienvenida de Windows.

2. . Desde la Barra de Tareas o Herramientas ("Taskbar") en Windows Xp, aplica un clic con el botón izquierdo del ratón sobre el icono de "Start"., el cual se encuentra en la esquina izquierda-inferior de la pantalla.

3. Lleve y apunte la flecha del ratón sobre el menú de "All Programs".

4. En el listado de la derecha aparece Microsoft Word.  Aplique un clic con el botón izquierdo del ratón sobre la selección de "Microsoft Word" (icono rotulado como Microsoft Word).  Estos pasos previamente descritos se pueden abreviar como:  Start > All Programs > Microsoft Word.  Existen otras maneras de abrir el programa de "Word":
a. Primera Alternativa: Aplique un clic sobre el botón el “Start”, luego seleccione “All Programs”.  A continuación, lleve la flecha del ratón sobre la alternativa de "New Office Document" (localizado comunmente en el extremo superior izquierdo del menú de "All Programs").  De ser necesario, aplique un click sobre el marcador o pestaña (“tab”) rotulado como "General" cuando aparezca la ventana de diálogo de "New Office Document".  Para crear un nuevo documento, aplique un  doble "click" rápido con el botón izquierdo del ratón sobre el icono de "Word", identificado "W" y rotulado como "Blank Document".  Podemos abreviar esa operación como: Start > All Programs > New Office Documente  >  General  >  Blank Document.
b. Segunda Alternativa: Si se ha empleado a Word anteriormente, simplemente, aplique un clic con el botón derecho del ratón sobre el botón de "Start", haga un clic sobre el icono de Microsoft Word ubicado en el menú de la izquierda (Start > Microsoft Word).
c. Tercera Alternativa: Desde el escritorio de Windows, aplique un doble clic sobre el icono de Microsoft Word.

5. Espere a que Word termine de cargarse.

6. A continuación, Microsoft Office debe comenzar, luego de unos segundos, debe aparecer un documento en blanco titulado “Document 1” en la ventana de Word (véase Figura ).  En esta pantalla se puede escribir inmediatamente.   Como fue descrito previamente, la pantalla está organizada con una serie de barras, además del área principal de trabajo.
7. Otra Opción:  Para crear un documento nuevo, diríjase al menú de File (ubicado en la barra del menú) luego a New.  Word nombra el primer documemto como “Document 1”

8. Obsérvese que también aparece un panel de tareas(“task pane”) de tareas titulado como “New Document” a la derecha de su pantalla y que los botones de la barra de herramientas se muestran en una sola fila.  Un panel de tareas (“Task Pane”) representa una ventana separada que permite al usuario llevar a cabo algunas tareas de Word más eficientemente.  Es recomendado que usted le dé un nombre al nuevo documento y lo guarde en su disco de almacenamiento.

CREAR UN DOCUMENTO
Para comenzar a escribir un documento se debe proceder como se indica a continuación:
1. En la Barra de Menú bajo la opción de File (Archivo) seleccione New (Nuevo).  Para acelerar el proceso puede escoger el ícono correspondiente en la Barra de Herramientas (). (File  > New).

2. Escoja el Formato: Papel, márgenes, tipo y tamaño de la letra y Justifique (“justification”).  En este primer ejercicio usaremos el Predeterminado (“Default”) que tiene el programa.
3. Cuando escriba una oración el cursor se moverá automáticamente hacia la próxima línea al llegar al final del papel.

4. Al terminar un párrafo oprimirá la tecla de [Enter].

5. Para indentar un párrafo utilice la tecla de [TAB] y no emplee la Barra Espaciadora (“Space Bar”) de su teclado.

6. La Barra Espaciadora la utilizará para separar una palabra de otra.

7. Para escribir todo en mayúscula (mayúscula sólida) oprima el [Cap Lock].  Se encenderá una luz en el teclado que le indicará que está funcionando.

8. Existen dos formas para escribir los acentos.  Un método consiste en configurar su teclado con el lenguaje “United States International”.  En este caso, solo aplique primero la tecla de las comillas y luego la vocal que desea acentuar.  La otra manera es utilizando el código de ASCII.  Aquí, oprima simultáneamente la tecla de [Alt] y el número que representa la letra.  Antes de oprimir el número asegúrese de que la tecla [Number Lock] esté activada.  Esto se sabe observando la luz verde en el panel de la calculadora.

9. Para dejar líneas oprima la tecla de [Enter].

GUARDAR UN DOCUMENTO

1. En la Barra de Menú bajo la opción File (Archivo) escoja Save As… (Guardar Cómo).
2. Le aparecerá la siguiente ventana.
3. Escoja Save As cuando por primera vez va a guardar en el disco, o cuando va guardar en otro formato.  Si estas dos condiciones no se dan, entonces puedo guardar mi documentos con el comando de File  >  Save.  La otra alternativa es emplear el icono de Save (dibujo de disco flexible) ubicado en la Barra de herramientas.
4. En la pantalla de “Save As” se pueden observar varias Cajas de Diálogo (“Dialog Box”).  Éstas son áreas en la pantalla donde usted tiene la oportunidad de escoger los que desea realizar:

a. Save in:  Usted aquí escogerá dónde guardará el documento (Ej., disco duro de la máquina, disco flexible, USB Flash Drive, entre otros).
b. File name:  Aquí usted escribirá el Nombre del Archivo.  La máquina de forma Predeterminada escribirá la primera oración que aparece en el documento como el nombre del archivo.  Al guardar la máquina escribirá luego del nombre le dio la extensión.  Esto es la identificación en que se trabaja.  En el Programa de Word la extensión es [.doc].
c. Save as type:  Guardar como tipo, se utiliza para cambiar el formato del programa.  Aquí encontrará distintas versiones de Programas (Ej., Word 3.1, Word Perfect 5.0, entre otras).  Esta Caja de Diálogo no es necesario seleccionarla a menos que tengamos diferentes versiones de un Programa o diferentes Programas en los que interesamos guardar el trabajo.

d. Save (Botón):  Se emplear para guardar el documento.  Lleve la flecha (o puntero) del ratón sobre este botón y aplique un clic con el botón izquierdo de este.
e. Cancel (Botón):  Se utiliza si se desea cancelar lo que se ha hecho hasta el momento.
Como guardar en formato Web

Parte 1: Guardar el documento como HTML

Comience con un documento nuevo.

Seleccione en el menú File > Save.

En el apartado Save as type escoja HTML document

En el apartado File name asígnele el nombre INDEX y guárdelo.

SALIR DEL DOCUMENTO

Para salir del documento y permanecer en el programa, Word puede utilizar una de las siguientes maneras:

1. En la Barra de Menú, escoja File (Archivo) y luego Close (Cerrar), o
2. En la Barra de Título, selecciones X.

SALIR DEL PROGRAMA WORD

Para salir de Word, puede seguir uno de los siguientes procedimiento:
1. En la Barra de Menú, escoja File (Archivo) y luego Exit (Salir).
2. Otra alternativa es, en la Caja Control, seleccione el icono de salir ([image: image4.bmp]).
EDITAR UN DOCUMENTO


Para editar un documento debe comenzar por seleccionar o bloquear la letra, palabra o sección que desea editar.  Al bloquear el área se pone de color negra con las letras blancas.  A continuación presentamos dos (2) formas de bloquear o seleccionar el texto:

1. Arrastrar el ratón con el botón izquierdo hundido a través del texto que desea modificar, y lo suelta al final.

2. La otra forma de editar un documento o texto es apretar la tecla de [Shift] mientras utiliza las teclas de movimiento del cursor en la dirección que desea bloquear e indica la flecha para marcar el texto que desea cambiar.

Las funciones para Editar un documento son las siguientes
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1. Cut (Mover o Cortar):  Con esta instrucción usted puede mover el texto de un lugar y ubicarlo en otro:
a. Selecciones el texto a mover bloqueándolo.
b. Seleccione en la Barra de Menú Edit y luego Cut.  Se observará que el texto desaparece.  En su lugar puede en la Barra de Herramientas seleccionar el icono que representa una tijera ([image: image6.bmp]).
c. Lleve el cursor al área dónde quiere poner el texto.  Seleccione en la Barra de Menú Edit y luego Paste,  el texto aparece.  En su lugar, puede seleccionar el icono que representa una tabla de apuntes o clip board de la Barra de Herramientas.
Como crear un hipervínculo

Parte 1: Crear un hipervínculo

En esta parte creará un “link” o hipervínculo que sólo diga Salumed, sin mostrar el URL al usuario.

Escriba Salumed y seleccione la palabra.

Seleccione en el menú Insert > Hyperlink.  En el apartado Link to File or URL escriba la siguiente dirección:

http://www.saludmed.com
Oprima OK.

El texto se volverá azul y aparecerá subrayado para indicar que es un hipertexto.

Oprima [ENTER]

EL ASISTENTE DE OFFICE ("OFFICE ASSISTANT")

El Asistente de Office ("Office Assistant") representa un sistema de ayuda en línea animado que provee recomendaciones y tópicos de ayuda mientras el usuario entra el texto en el programa.  El Asistente de Office ("Office Assistant") también permite realizar una búsqueda de información de ayuda.
Para realizar una búsqueda de información de ayuda:
1. Aplique un clic con el botón izquierdo del ratón sobre el Asistente de Office ("Office Assistant"), de manera que se exhiba la caja de diálogo titulada "What Would You Like to Do?".

2. Escriba el nombre del tópico que desee buscar.

3. Aplique un clic sobre "Search".

Para cambiar las opciones del Asistente de Office ("Office Assistant"):

1. Aplique un clic con el botón izquierdo del ratón sobre el Asistente de Office ("Office Assistant").

2. Aplique un clic sobre "Options" para poder acceder la caja de diálogo del Asistente de Office ("Office Assistant").

3. De ser necesario, aplique un  clic sobre el marcador de "Options".

4. Seleccione o deseleccione las opciones deseadas.

5. Aplique un clic sobre el botón de "OK".

Para cerrar el Asistente de Office ("Office Assistant"), aplique un clic sobe el botón de cerrar (identificado con una "x").  Para que aparezca el Asistente de Office ("Office Assistant"), aplique un clic sobre el botón de Asistente de Office ("Office Assistant) ubicado en el extremo derecho de la Barra de Herramientas Estándar.

EJERCICIOS DE PRÁCTICA

El estudiante habrá de crear un plan de unidad, plan diario, un examen, carta y un resumé (empleando "Word's Wizards").  Además, se le requiere que el estudiante incluya en uno de estos documentos un listado (viñetas o "bullets", en Inglés), tabla, e importar una imagen o "clip art".  Antes de comenzar con estos documentos, el estudiante debe de crear una carpeta ("folder") rotulada "Word", la cual debe estar dentro de la carpeta principal de "Documentos".  Bajo esta carpeta se deben guardar los documentos antes mencionado.  Todos estos documentos se deben guardar en el formato de "Word Document" (.doc) y en el formato de "World Wide Web" o "HTML Document" (.htm).  Para cambiar de formato, seleccione "File" (aplique un clic aquí con el botón del ratón izquierdo), luego "Save As".  Primero guarde su documento en formato de "Word".  Para realizar esto, asegúrese que bajo el encasillado rotulado como "Save as type:" se lea "Word Document (*.doc)".  Luego en el encasillado de "File name:" escriba el nombre correpondiende de su documento (véase los próximos ejercicios).  Una vez más, aplique un "click" sobre "File", luego "Save As".  Ahora debe cambiar el encasillado de "save as type" para que lea "HTML Document (*.html;*.htm;*.htx)".  Otra opción es seleccionar "Save as HTML" bajo "File".  Es importante recordar que todos los documentos guardados en formato de HTML deben de colocarse en la siguiente carpeta del disco "floppy" (A): A:/Internet/WWW/Portfolio). Como se observa, se debe crear una carpeta llamada "Internet", y dentro de ésta otra carpeta rotulada como "WWW", y otra más con el nombre de "Portafolio".  Para poder cambiar de carpetas desde el la ventana de "Save As", en el encasillado de "Save in", busque "3½ Floppy (A)", luego seleccione y abra las carpetas de "Internet", "WWW" y "Portafolio".  Una vez en la carpeta de "Portafolio", guarde su documento (como HTML).
Ejercicio #1: Crear un "Plan de Unidad":

1. Si no se encuentra el "Word", diríjase a "Start", luego a "Programs", y seleccione "Microsoft Word".

2. 2. Escoja "New", desde el menú de barra o en la barra de herramientas estándar.

3. Escriba el Plan de Unidad:
	I. TITULO DE LA UNIDAD:  Los Animales 
II. EXPOSICION O SIGNIFICACION DEL TEMA DE LA UNIDAD

Los animales interaccionan directa o indirectamente con los seres humanos. Los animales domésticos conviven en muchos hogares.  Es importante conocer donde viven, de que se alimentan y como se agrupan, de manera que se pueda apreciar su importancia y cuidarlos.
Esta unidad esta diseñada para ayudar a los estudiantes observar y conceptuar que los animales son seres vivientes. Los estudiantes podrán apreciar el fenómeno único/singular de los animales recién nacidos y cómo los animales cambian.  Se le provee la oportunidad a los estudiantes de que comparen cuanto cuidado maternal ofrecen los diferentes animales.
III. OBJETIVOS GENERALES 

      A. Cognoscitivos (De Conocimientos)  

           Al terminar esta unidad, se espera que los estudiante puedan:  

           1. Identificar los tipos de animales y sus crías.  

           2. Descubrir que hay animales que tienen huesos (vertebrdos) y otros que no lo
               tienen (invertebrados).  

           3. Localizar sus áreas geográficas donde viven. 
           4. Conocer de que se alimentan.  

      B. Psicomotores (De Habilidades y Destrezas):  

           Al finalizar esta unidad, se espera que los estudiante puedan:  

           1. Dar de comer a un perrito.  

           2. Peinar un perrito.  

      C. Afectivos (De Apreciaciones y Actividades) 

           Al finalizar esta unidad, se espara que los estudiante puedan:  

          1. Reconocer que un animal siente y padece como todo ser humano.  

          2. Apreciar los animales y evitar su maltrano.  

IV. OBJETIVOS ESPECIFICOS 

      A. Cognoscitivos (De Conocimientos)  

           Al finalizar esta unidad, se espera que los estudiante puedan:  

           1. Clasificar los seres vivientes en aquellos que son animales y los que no son 
               animales.  

           2. Reconocer el ciclo vital de los animales.  

           3. Identificar las características de un animal joven.  

           4. Inferir porqué diferentes animales necesitan diferentes cantidades de 
               alimentos.  

           5. Definir cadenas de alimentos.  

           6. Identificar el tipo de mascota que posee el estudiante en su casa.  

           7. Identificar que hace y cuanto come al día el mascota del esudiante.  

      B. Psicomotores (De Habilidades y Destrezas):  

         Al finalizar esta unidad, se espera que los estudiante puedan:  

         1. Crear un ambiente propicio y alimentar un pajarito en una jaula.  

         2. Dar de comer a una paloma.  

      C. Afectivos (De Apreciaciones y Actividades)  

         Al finalizar esta unidad, se espera que los estudiante puedan:
         1. Comunicarse con los animales.
         2. Apreciar un nacimiento de un animal.
V. BOSQUEJO DEL CONTENIDO
     A. Clasificación de los Seres Vivos.
          1. Animales.
          2. No animales.

     B. El Ciclo Vital de los Animales  

     C. Los Animales y sus Necesidades  

          1. El alimento y agua.  

          2. Refugio.  

          3. Espacio.  

          4. Hábitats.  

    D. Las Cadenas de Alimentos. 

    E. Nacimiento y Cuidado de los Animales.
        1. Las crías de los animales.  

        2. Empollar.
        3. Cómo cambian las crías.
        4. Cómo alimentar y proteger las crías.
VI. ACTIVIDADES INICIALES 

      1. Estudio de láminas en un tablón de edicto de diferentes seres vivos y sus crías.
      2. Experiencias de los alumnos con sus mascotas.
      3. Gira a un zoológico y a una finca.
      4. Lectura y discusión de una noticia sobre el "maltrato de los animales".

      5. Visita al salón de clase de un veterinario.  

VII. ACTIVIDADES PARA EL DESARROLLO DE LA UNIDAD 

        1. Celebrar "el día del animal doméstico", en el cual los alumnos tienen que traer a
            la escuela su mascota y 

            mostrar cómo lo cuidad. 

        2. Actividad de "cómo cambia la oruga".  

        3. Uso de programas multimedios interactivos en CD-ROM para 
            microcomputadoras relacionados con seres vivos/animales.  

       4. Los estudiantes prepararán un cartelón que muestre los períodos de gestación 
           en diferentes especies de animales.

       5. Los estudiantes buscarán y anotarán en sus alrededores (ejemplo: patio de su
           casa, parque, jardín, entre 

           otros lugares) aquellas cosas que viven, las que no viven y las que provienen de 
           un ser vivo.

VIII. ACTIVIDADES CULMINANTES 

        A. Exhibición de Trabajos
              Al finalizar esta unidad, los estudiantes habrán de presentar todos sus trabajos, experimentos y relatar sus experiencias personales con los animales y visitas al zoológico.  

        B. Resumen de la Unidad  

             El maestro habrá de traer a la clase los puntos más importantes estudiados en esta unidad.  

IX. BIBLIOGRAFIA 

      A. Libros para el Estudiante  

          Cooper, E.K., Blackwood, P.E., Boeschen, J.A., Giddings, Morsley G., & Carin, A. A. (1985). HBJ Ciencias. Orlando, FL: Harcourt Brace Jovanich, Inc.  

          Curbelo Ruiz, J., & Hernández Prudencio Zuarzo, M.T. (1979). LaCiencia-2. Madrid: Ediciones S.M. Horizontes en Ciencias 3: Recursos para el Estudiante. (1991). Morristown, NJ: Silver Burdett & Ginn.  

          Mallinson, G.G., Mallinson J.B., Smallwood, W.L., & Valentino, C. (1985). Sirver Burdett Ciencias. Morrison, NJ: Silver Burdett Company.  

          Sund, R.B., Adams, D.K., Hackett, J.K., & Moyer, R.H. (1985). Enfasis en la Ciencia. Columbis OH: Charles E. Merril Publishing Co.  

B. Libros para el Maestro  

          Cain, S.E., & Evans, J.M. (1984). Sciencing: An Involvement Aproach to Elementary Science Methods. (2nd. ed.) Columbus, OH: Charles E. Merrill Publishing Company.  

          Carin, A.A., & Sund, R.B. (1985). Teaching Modern Science. (4th. ed.) Columbus, OH: Charles E. Merrill Publishing Company. Enseñanza de las Ciencias Naturales. Segundo Grado. Libro del Maestro. SM.  

          Sund, R.B., Adams, D.K., Hackett, J.K., & Moyer, R.H. (1985). Enfasis en la Ciencia. Edición Anotada para el Maestro. Columbis OH: Charles E. Merril Publishing Co.
X. EVALUACIÓN 

    A. Criterios Empleados para Evaluar el Trabajo de los Estuantes  

         1. Trabajos de creación:  

             De las actividades y experimentos de desarrollo.  

         2. Preparación de proyectos.  

         3. Pruebas escritas.  

         4. Lecturas especiales.  

         5. Participación de los estudiantes en clase.  

XI. DURACION DE LA UNIDAD 

Tiempo Aproximado              :          4 semanas  

Fecha en que se Inicia           :          1 de marzo de 1998  

Fecha en que Termina           :          30 de marzo de 1998  

XII. COMENTARIOS AL FINALIZAR EL DESARROLLO DE LA UNIDAD 

        Se tuvo que traer un zoólogo en ves de un veterinario durante las actividades de inicio. No se pudo hacer la visita a una finca. En su lugar, se realizó una gira al Yunque, donde los estudiantes identificaros los diferentes tipos de animales que existen en este hábitat.


4. Al finalizar de escribir el texto, guarde su documento bajo el nombre de "PlanUnidad".  Escoja "File", seguido de "Save As".  Luego de escribir el nombre de su archivo ("PlanUnidad") bajo "File name", aplique un clic sobre el botón de "Save".  Previo a este proceso, es importante que usted se en encuentre (dentro del encasillado rotulado "Save in") en el disco "3½ Floppy (A:)" y dentro de su carpeta correspondiente.  Recuerde que este documento debe guardarse en el formato de .doc y .htm.

5. Cierre su archivo de "PlanUnidad".  

Ejercicio #2: Crear un "Plan Diario":
1. Suba el programa de "Word".
2. Aplique un clic sobre el botón de "New" (ilustrado con un icono que representa una página en blanco) localizado en la barra de herramientas estándar.  Esto abre un documento en blanco.

3. Presione la tecla de [Caps Lock] y escriba: “PLAN DIARIO” (sin las marcas de cotejo) en mayúsculas.

4. Continúe escribiendo en el área de texto, según el siguiente plan:

	TITULO              :    Los Animales  

TEMA                 :    Características de los Animales Domésticos  

OBJETIVOS    :  

               A. Cognoscitivos  

                    1. Luego de observar y discutir una serie de láminas de diferentes animales, los estudiantes 

                        identificarán los animales domésticos.  

              B. Psicomotor  

                  1. Dibujarán y colorearán un animal doméstico.  

              C. Afectivo  

                  1. Expresarán sus sentimientos hacia su animal.  

MATERIALES :  

Lámimas de animales domésticos.  

Papel mimeografiado con dibujos de animales. 

Libro de texto.  

PROCEDIMIENTO :  

              A. Exploración  

                   1. Canción La Finca de Papá - Comentarios  

                   2. Conversación sobre sus experiencias espontáneas con animales.  

             B. Conceptualización  

                 1. Presentación de láminas para observación y discusión de animales domésticos.  

                 2. Identificación de los animales domésticos en láminas presentadas.  

                 3. Señalar o mencionar las características físicas de esos animales domésticos.  

                 4. Escoger el animal de su preferencia y describirlo físicamente.  

             C. Aplicación  

                 1. Formación de grupos para contestar preguntas relacionadas con el  tema y luego dibujarán y 

                    coloreará un animal doméstico.  

ASIGNACION           :  Traer recortes de láminas de animales domésticos.


5. Luego de haber terminado el examen, aplique un "click" sobre "File", luego seleccione "Save As", y escriba en el recuadro rotulado "File name", "PlanDiario" aplique un clic sobre el botón de "Save".  Asegurarse que usted se en encuentre (dentro del recuadro de "Save in") en el disco "3½ Floppy (A:)" y dentro de su carpeta correspondiente.  No se olvide que este documento debe guardarse en el formato de .doc y .htm.
6. Revise su documento.  Si realiza algún cambio, guarde el documento (aplique un clic" sobre el botón que representa un disco "floppy", ubicado en la barra de herramientas estándar).

7. Cierre su documento.  Desde el menú de barra principal, aplique un clic sobre "File", y luego escoja "Close".
Ejercicio #3:  Crear Exámenes:
1. Active el programa de "Word".

2. Abra un documento nuevo. Realice un clic sobre el botón de "New" (identificado con una página en blanco), el cual se encuentra en la barra de herramientas estándar.
3. Escriba el Examen:
Primer Ejemplo:
	EXAMEN :  Unidad: Los Animales

	Nombre _________________________________ Fecha ________________________

Grupo _____________ Núm. Estudiante ___________________

Completa lo siguiente:

1. ¿Que características tienen los animales?:  

    a. Los animales comen.  

    b. ____________________________________________________________.  

    c. ____________________________________________________________.  

2. ¿Que comen los animales?:  

    a. ____________________________________________________________.  

    b. ____________________________________________________________.  

3. ¿Que otras cosas necesitan los animales?:  

    a. ____________________________________________________________.  

    b. _____________________________________________________________.  

    c. _____________________________________________________________.  

Coloca a estos animales en dos columnas, según nazcan de un huevo o directamente de la madre:

Perro Llama Colibrí Salmón Canguro

Mosca Vaca Abeja Cangrejo Caballo
NACEN DE UN HUEVO

NACEN DE LA MADRE

Escribe en el cuadro los nombre de los animales que aparecen en la lista:
León, culebra, avispa, coquí, mosca, pitirre, vaca, cbra, gallina, oruga, elefante, conejo, carite, caballo, cerdo, saltamontes.
SE AGRUPAN SOLOS

LOS AGRUPA EL HOMBRE

VIVEN SOLOS




Selección Múltiple:

En este ejercicio apreciaremos la capacidad de Word para enumerar automáticamente.

Parte 1: Escribir el encabezado del examen

En un documento nuevo escriba un encabezado apropiado para el examen.

Ejemplo
Escuela Sutana de Tal

Distrito de Macondo

Primera prueba corta

5 puntos 

Centralícelo y cambie su tamaño y tipografía a gusto.

Parte 2: Escribir espacio para identificación

Abra dos líneas en blanco debajo del encabezado oprimiendo dos veces la tecla [ENTER].  Escriba lo siguiente:

Nombre:

Identificación:

Parte 3: Escribir instrucciones 

Oprima [ENTER] dos veces para insertar dos líneas debajo de Identificación: 

I. Escoja la mejor alternativa

Oprima [ENTER] dos veces para abrir dos líneas en blanco nuevas.

Parte 4: Escribir preguntas

Es en esta parte donde verá la enumeración automática en acción.

Escriba esto como primera pregunta:

1) ¿Cuál de los siguientes no es un verbo?

Oprima [ENTER].

Notará que automáticamente aparece el número 2.  Lo que deseamos es añadir alternativas con letras (a, b, c…).Borre el 2 oprimiendo la tecla [ENTER].

Oprima la tecla [TAB] para indentar las alternativas.  Usualmente se encuentra a la izquierda en su teclado y a veces se representa con dos flechas apuntando en direcciones opuestas.

Escriba la primera alternativa dejando dos espacios luego de la letra:

a) Correr

Oprima [ENTER].    Observará que Word inserta la letra  b  automáticamente y con la misma indentación.  ¿Qué le parece?

Escriba las demás alternativas oprimiendo [ENTER] luego de cada una.

a) Correr

b) Saber

c) Suplidor

d) Estudiar

Luego de escribir la última alternativa notará que aparece la letra e. 

Como nos limitaremos a cuatro alternativas tenemos que borrarla.  Para hacerlo sólo oprima la tecla [ENTER] de nuevo.  Notará que se borrará la letra y también se abrirá una nueva línea en blanco.

Escriba la segunda pregunta:

2) La palabra “extravagante” en la oración “Lucía un sombrero extravagante”.  tiene rol de:

Repita todos los pasos anteriores para las cuatro preguntas.  En la siguiente página está la prueba completa.
	Escuela Nueva Tecnología
Distrito de Mameyes
Primera Prueba Corta

4 puntos

Nombre:

Identificación:

Escoja la mejor alternativa

1) ¿Cuál de los siguientes no es un verbo?

a)  Correr

b)  Saber

c)  Suplidor

d)  Estudiar
2) La palabra extravagante en la oración “Lucía un sombrero extravagante tiene rol de:

a)  Verbo

b)  Adjetivo

c)  Adverbio

d)  Sustantivo

3) ¿Cuál de estas listas contiene solamente preposiciones:?

a)  entre, según, para

b)  con, sin, y 

c)  largo, bajo, oloroso 

d)  ella, desde, muy

4) ¿Cuál de estas listas contiene solamente conjunciones:?
a)  y, nada, cabe

b)  para que, con que, luego

c)  mucho, poco, silla

d)  fácilmente , japonés, con




Examen con Pareo:

Como un pareo típico consiste en dos columnas usaremos una tabla para organizarlo fácilmente.

Parte 1: Escribir el encabezado del examen

En un documento nuevo escriba un encabezado apropiado para el examen.

Ejemplo

Escuela Sutana del Tal

Distrito de Macondo

Segunda prueba corta

10 puntos

Centralícelo y cambie su tamaño y tipografía a gusto.

Parte 2: Escribir espacio para identificación

Abra dos líneas en blanco debajo del encabezado oprimiendo dos veces la tecla [ENTER].  Escriba lo siguiente:

Nombre:

Identificación:

Parte 3: Escribir instrucciones 

Escriba dos líneas debajo de Identificación:

I.  Haga la mejor asociación posible entre los ítems en la columna izquierda y los de la derecha.]

Oprima [ENTER] dos veces para abrir dos nuevas líneas en blanco.

Parte 4: Creación de la tabla para el pareo

En esta parte crearemos una tabla de una fila y dos columnas.  La tabla no debe ser visible en la prueba.  No luciría muy bien.  Mientras creamos el pareo dejaremos los bordes de la tabla sólo como referencia.  Al final haremos la tabla “invisible”.

Seleccione el menú Table > Insert Table…

En la ventana que aparece indique que desea una fila (row) y dos columnas (columns)
Oprima el botón OK.  Aparecerá algo así:

	
	


Parte 5: Escribir el pareo

Dentro de la primera columna de la tabla escriba el primer ítem

______ 1.  Júpiter 

Para lograr la línea antes del 1 utilice el “underscore” oprimiendo en el teclado [Shift] y la tecla de “underscore”. (En caso de dudas preguntar al profesor)

Oprima [ENTER] y escriba el resto de los ítems de la misma manera.

______ 1.  Júpiter 

______ 2.  Venus

______ 3.  Solsticio

______ 4.  Equinoccio

______ 5.  Sol

______ 6.  Plutón

______ 7.  Mercurio

______ 8.  Eclipse solar

______ 9.  Eclipse lunar

______ 10.  Titán 

En la segunda columna escribiremos las opciones identificándolas con letras. Deje dos espacios luego de la letra y oprima [ENTER] luego de cada opción para que Word inserte automáticamente la próxima letra.

A. Planeta con órbita retrógrada

B. Día más largo del año

C. La luna se ubica entre el Sol y la Tierra

D. Un satélite de Saturno

E. El planeta más pequeño del sistema solar

F. La Tierra se ubica entre la Luna y el Sol

G. El planeta más grande del sistema solar

H. El planeta más cercano al Sol

I. La estrella más cercana a la Tierra

J. Días en el año en que el día y la noche duran casi lo mismo

K. Un cometa famoso

Es posible que las oraciones sean muy largas para la tabla.  Para cambiar el ancho de la columna acerque el puntero al borde izquierdo o derecho de la columna.  Cuando esté justo sobre el borde, el puntero cambiará su apariencia a    indicando que puede alterar el ancho oprimiendo el botón izquierdo del mouse y arrastrándolo.

Hacer invisible la tabla 

Antes de seguir con este paso debe asegurarse de que el cursor está dentro de la tabla.

Seleccione en el menú Format > Borders and Shading…
Dé un clic en la pestañita Borders.
En la sección Settings seleccione la opción None.

Oprima OK.  Los bordes deben desaparecer.

Las siguientes páginas muestran el pareo con bordes y sin bordes.

Escuela Sutana de Tal

Distrito de Macondo 

Segunda prueba corta

10 puntos

Nombre:

Identificación:

Haga la mejor asociación posible entre los ítems en la columna izquierda y los de la derecha.



	
	


Escuela Sutana de Tal

Distrito de Macondo 

Segunda prueba corta

10 puntos

Nombre:

Identificación:

Haga la mejor asociación posible entre los ítems en la columna izquierda y los de la derecha.



	
	


Examen Pictórico:
En este ejercicio sacará provecho de las herramientas de dibujo de Word para crear pruebas con alto contenido pictórico, apropiadas para estudiantes de escuela elemental y pre-escolar.  Nuevamente usaremos tablas para organizar los ejercicios.  En esta ocasión no eliminaremos los bordes.

Escribir el encabezado

En un documento nuevo escriba un encabezado apropiado

Ejemplo

Cuenta los objetos y escribe el número.

Kindergarten

Sr. Pérez 

Ajuste a su gusto el tamaño y tipografía.  Centralícelo si desea.

Crear la tabla para los ejercicios 

Seleccione el menú Table >Insert Table…
En la ventana que aparece indique que desea cinco filas (row) y dos columnas (columns)
Oprima el botón OK.  Aparecerá algo así:

	
	

	
	

	
	

	
	

	
	


Crear los ítems 

En esta sección es donde empezaremos a dibujar figuras para que los niños cuenten.  Las figuras estarán en la primera columna y los niños escribirán en la segunda.  Como los dibujos deben ser grandes, necesitaremos espacio dentro de la tabla.

Para tener suficiente espacio dentro de la tabla dé un clic dentro de la primera celda y oprima [ENTER] cinco veces.  Esto abrirá espacio para cinco líneas nuevas.  Note que la fila entera se expande.

Repita el paso anterior en cada celda de la primera columna.

En la barra de dibujo seleccione Autoshapes > Basic Shapes.

[image: image7.png]yaw~ [} | Adtoshapes~ N\ % [1 O B 4l




	[image: image8.png][mYsAvES
o0AN
[eXoY=le}
6000
[SeIors
«
\[JOO
14>





	En este momento probablemente se sienta tentado a jugar con todas las figuras del menú y a no seguir las instrucciones.  Está bien.  ¡No podemos matar las ansias creativas! En la próxima página vera una muestra de lo que puede crear.  Lea más abajo para aprender cómo lograr algunos de esos efectos.




Para seleccionar los objetos dé un clic sobre ellos.

Cambie el tamaño de los objetos usando los nodos de los lados y de las esquinas:

Usando la barra de dibujo puede hacer lo siguiente:

Para cambiar el color del interior (“fill color”) seleccione el objeto y oprima el pequeño triangulo en el botón con la paila de pintura.  Aparecerá una paleta de colores.  Si selecciona Fill Effects… podrá aplicar otros efectos especiales como gradación de dos colores y texturas.

Para cambiar el color de los bordes (“line color”) seleccione el objeto y oprima el pequeño triángulo en el botón con la brocha de pintar.

Los últimos dos botones de la barra de dibujo son para crear efectos de sombra o tridimensionales en el objeto seleccionado.

¡Diviértase!
	Cuenta los objetos y escribe el número.

Kindergarten

Sr. Pérez
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4. Al finalizar de escribir toda la información, guarde su documento bajo el nombre de "Examen1". Escoja "File", seguido de "Save As".  Luego de escribir el nombre de su  archivo ("Carta1") bajo "File name", aplique un clic sobre el botón de "Save".  Es importante asegurarse que usted se en encuentre (dentro del recuadro de "Save in") en el disco "3½ Floppy (A:)" y dentro de su carpeta correspondiente.  Recuerde que este documento debe guardarse en el formato de .doc y .htm.

5. Cierre su archivo de "Examen1".

Ejercicio #4: Escriba una "Carta":

1. Si no se encuentra el "Word", diríjase a "Start", luego a "All Programs", y  seleccione "Microsoft Word".
2. Escoja "New", desde el menú de barra o en la barra de herramientas estándar.
3. Escriba su carta (ejemplo):
	August 25, 2000  

Dr. William D. Doe

The Teachers College Department

University of John Doe, NY 11001

Dear Sir:

My name is ____________________________ and I have a B.A. in Elementary Education. I expect to enroll in a graduate program in order to obtain a Master degree, majoring in Multimedia Technology Education.

I would be very grateful if you could send me all necessary available information in relation to admittance to Teachers College.

In addition, I shall also de appreciated if you also order for me information regarding economic assistance, information about scholarships, boarding facilities, etc.

A prompt reply to my request shall be greatly appreciated.

Sinserely yours, 

___________________




4. Al finalizar de escribir el texto, guarde su documento bajo el nombre de "Carta1". Escoja "File", seguido de "Save As".  Luego de escribir el nombre de su archivo ("Carta1") bajo "File name", aplique un clic sobre el botón de "Save".  Es importante asegurarse que usted se en encuentre (dentro del recuadro de "Save in") en el disco "3½ Floppy (A:)" o Flash Drive y dentro de su carpeta correspondiente.  Recuerde que este documento debe guardarse en el formato de .doc y .htm.
5. Cierre su archivo de "Carta1".
Ejercicio # 5: Creando un "Resumé" empleando "Word's Wizards":
1. Comience "Word":
· Diríjase a "Start", luego a "New Office Document" (aplique un clic aquí), de ser necesario, aplique un "click" en el marcador rotulado "Other Documents". Ejecute un"click" sobre el icono rotulado "Resume Wizard".
2. Emplee el "Resume Wizard" para crear un resume:
· Aplique un clic en el botón de "OK".  Debe ahora aparecer el recuadro de diálogo de "Resume Wizard".  Lleve a cabo un clic sobre el botón de "Next".  Debe verse en estos momentos la ventana de Start ("Start panel").
· Aplique un clic sobre el botón de "Next".  La pantalla mostrará la ventana de Estilo ("Style panel").  Seleccione "Professional", y luego ejecute un clic sobre el botón de "Next".  Se exhibe ahora la ventana de Tipo ("Type panel").
· Seleccione "Entry-level résumé".  Aplique un clic sobre el botón de "Next". Aparecerá la ventana de Dirección ("Address panel").

3. Personalice su resume.
1. Dentro de la ventana de Dirección ("Address panel"), escriba su nombre completo (bajo "Name"), luego presione la tecla de [Tab].  Debe estar ahora en el encasillado de "Address".  Escriba aquí su dirección.  Presione la tecla [Enter] para crear otra línea.  Cuando termine, presione la tecla de [Tab] para moverse al encasillado de "Phone" (teléfono).  Entre su número telefónico y luego presione la tecla de [Tab] para avanzar al encasillado de "Fax".  Cuando termine, una vez más presiona [Tab].  Debe estar ahora en el encasillado de "E-mail" (correo electrónico).  Escriba su correo electrónico.  Al terminar toda esta información, aplique un click sobre el botón de "Next".  Usted deberá poder observar ahora la ventana de "Standard Headings" (Encabezados Estándar).
2. Coteje (con un clic del ratón) los siguientes encabezados para su resume: "Objective" (Objetivo), "Education" (Educación o Preparación Académica), "Award Received" (Premios y Honores), "Work Experience" (Experiencia de Trabajo), "Volunteer Experience" (Experiencia como Voluntario), y "References".  Estos encabezados aparecerán en inglés en su documento.  No obstante, esto se podrá editar al finalizar el "Résumé Wizards".  Aplique un clic al botón de "Next".  Se puede apreciar la ventana de "Optional Headings" (Encabezados Opcionales).  Solo seleccione las siguientes alternativas si aplican para usted: "Professional memberships" (Membresías de asociaciones profesionales), "Acreditations and Licences" (acreditaciones y licencias), y "Patent and publications" (publicaciones).  Lleve a cabo un clic sobre el botón de "Next".  Debe de poder observarse la ventana de "Add/Sort Heading".

3. En la ventana de "Add/Sort Heading" usted podrá añadir otros encabezados a su resumé.  Además podrá eliminar aquellos que no desee.  Ejecute un clic en el botón de "Next".  Finalmente, aparecerá la ventana de "Finish" (Terminar).

4. Si no necesita hacer ningún cambio, aplique un clic sobre el botón de "Finish". De lo contrario, seleccione el botón de "Back", para poder realizar las alteraciones pertinentes.

5. Entre ahora toda la información de usted en cada uno de los encabezados del resume.
4. Visualice las páginas en su totalidad su resume:  

Aplique un clic sobre el botón de "print preview".  Este se encuentra ubicado en la barra de herramientas estándar (un botón identificado con una página en blanco y una lupa).
5. Guarde el resume. Bajo "File", seleccione "Save As". escriba: "Resume de ______(su Nombre)", luego aplique un clic sobre el botón de "Save".
Recuerde que este documento debe guardarse en el formato de .doc y .htm dentro de sus carpetas correspondientes.
Ejercicio # 6: Creando un Letrero  (Afiche o Anuncio "Poster"):

En este ejercicio los se creareá un letrero en una página orientada horizontalmente (landscape), usando imágenes y bordes.  Haga lo siguiente en un nuevo documento:

1. Cambie la orientación de la página:
· Para hacer que la página imprima en formato horizontal diríjase al menú de File y luego seleccione Page Setup (File > Page Setup…).
· Aplique un clic sobre la pestaña (“tab”) rotulada como “Paper size”.
· En el recuadro titulado “Orientation”seleccione “Landscape”.
· Asegúrese de que en el apartado “Apply to”aparezca el texto “Whole document”.
· Oprima el botón rotulado como “OK”.

2. Escriba parte del letrero:
· Supondremos que desea usar el letrero para poner su nombre en la puerta del salón.
· Escriba su nombre y materia de enseñanza.  Por ejemplo:

Sr. Julio Morales Toro
Educación Física

· Centralice el texto, cambie la tipografía a su gusto, cambie el tamaño y hasta el color.  Termine cuando le parezca que ha logrado una apariencia apropiada.

· Oprima por lo menos DOS veces la tecla [ENTER] del teclado.  Esto abrirá espacio para insertar una imagen.

3. Insertar una imagen:
· Asegúrese de que el puntero está DEBAJO del encabezado que acaba de escribir.
· Seleccione en el menú Insert > Picture > Clip Art…
· Aparecerá una ventana con muestras de imágenes organizadas por categoría.  Explore las categorías y escoja una imagen apropiada para su letrero.  La siguiente imagen la escogimos para el ejemplo:

[image: image14.png]‘l




· Para alterar el tamaño de la imagen “agárrela” con el ratón por cualquiera de los nodos y expándala o comprímala a su gusto.

4. Añadir un borde a la página

· Diríjase a “Format” (desde la barra de menú)  y escoja “Border and Shadings” (Format. > Borders and Shadings
· Aplique un clic a la pestaña titulada como “Page Border”
· En la columna Style busque el apartado Art.  Este apartado contiene una lista de posibles decoraciones.  Seleccione uno de los diseños.
· En el apartado Width le recomiendo que escriba o seleccione 21 pt.  Esto es el ancho de la imagen que se usa para decorar – en este caso la manzanita que ve en la figura.  Por supuesto, esto lo puede cambiar a su gusto.
· En esa misma ventana oprima el botón Options… y aparecerá esta otra ventana:

· En el apartado Measure from seleccione Text.  Esto hará que el borde se ubique con respecto al texto y no con respecto a los filos de la página.

· En la sección Margin asegúrese de tener estos valores 

Top            1 pt

Bottom      2 pt

Left          12 pt

Right        12 pt

· Con los valores anteriores, usualmente, se obtienen mejores resultados.  Poner bordes a las páginas en Word no es tan fácil.  Si algunos bordes no aparecen en el Print Preview debe alterar los valores que escribimos arriba.

· Oprima “OK”hasta que regrese al documento.
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Ejercicio # 7: Lista de Asistencia:


En este ejercicio de práctica crearemos una lista para tomar asistencia.   Diseñaremos una tabla y organizaremos los nombres en orden alfabético.
1. Escribir el encabezado:
· Escriba un encabezado con el nombre de su escuela, distrito, su grupo y su nombre.  Enfatícelo y centralícelo en la página.  A continuación un ejemplo:
Escuela Nueva Tecnología

Distrito de Mameyes

Grupo 5-6

Mr.. Julio Morales Toro

· Abra unas cuantas líneas en blanco debajo del encabezado.  Escriba Fecha: y oprima [Enter]

2. Crear la tabla:
· Seleccione el menú Table > Insert Table…

· En la ventana que aparece especifique una tabla de tres columnas y once filas.

· Oprima el botón Autoformat y escoja un formato atractivo para la tabla.  Para continuar el ejemplo seleccionemos el estilo Grid 1.

3. Escribir ,los encabezados de la tabla

· La primera fila llevará los encabezados de cada columna:

Primer encabezado: Nombre

Segundo encabezado: Seguro Social
Tercer encabezado: Firma

4. Escribir los nombre de los estudiantes

· La primera columna llevará los nombres de diez estudiantes; la segunda columna el número de Seguro Social y la tercera columna donde ellos firmen o usted marque la asistencia.  Sin cambiar su orden, puede usar los siguientes nombres y números ficticios

Cruz Rivera Yesica          597-43-5157

Brito Rosado, Alan           802-48-4947

Luz del Alba, Soyla          897-31-9361

Chufe Blanco, Helen        597-45-4441

González Cruz, Rosaura   597-47-6465

Delgado Miranda, Juan     553-31-8395

Martínez Robles, Ricardo 597-45-7454

Villa Del Mar, Mara         597-48-9998

Linda Del Río, Pepita       597-45-7787

Molina Molina, Matilda    597-45-1234

· Los nombres intencionalmente se dejaron fuera de orden alfabético.  En el siguiente paso se resolverá ese problema.

5. Ordenar nombres alfabéticamente

· Asegurándose de tener el cursor dentro de la tabla, seleccione el menú Table > Select Table.  Esto seleccionará todo el contenido de la tabla incluyendo los encabezados.

· Seleccione el menú Table > Sort.  Aparecerá esta ventana:
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· Casi al final de la ventana busque la opción Header Row y márquela. Con esto le decimos al programa que la primera fila contiene el nombre de cada columna.

· En el apartado “Sort by” escoja la columna Nombre como clave para ordenar.

· Seleccione ordenar en forma ascendente (ascending).  Eso ordenará los nombres desde la A hasta la Z.

· Oprima el botón OK.  Los nombres quedarán ordenados junto con sus respectivos números de Seguro Social.

6. Insertar un  borde decorativo

· Desde el menú de barra, seleccione  “Format”, luego “Borders and Shading” (Format. > Borders and Shadings).
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· Aplique un clic a la pestaña titulada como “Page Border”

· En la columna Style busque el apartado Art.  Este apartado contiene una lista de posibles decoraciones.  Seleccione uno de los diseños.
· En el apartado Width le recomiendo que escriba o seleccione 21 pt.  Esto es el ancho de la imagen que se usa para decorar – en este caso la manzanita que ve en la figura.  Por supuesto, esto lo puede cambiar a su gusto.
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· En esa misma ventana oprima el botón Options… y aparecerá esta otra ventana:
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· En el apartado Measure from seleccione Text.  Esto hará que el borde se ubique con respecto al texto y no con respecto a los filos de la página.

· En la sección Margin asegúrese de tener estos valores 

Top            1 pt

Bottom      2 pt

Left          12 pt

Right        12 pt

· Con los valores anteriores, usualmente, se obtienen mejores resultados.  Poner bordes a las páginas en Word no es tan fácil.  Si algunos bordes no aparecen en el Print Preview debe alterar los valores que escribimos arriba.

· Oprima “OK”hasta que regrese al documento.
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Ejercicio # 8: Reportes de Notas Personalizadas
Suponga que tiene cuarenta estudiantes en su grupo y desea entregarles reportes individuales de notas.  Sin computadoras esto implicaría escribir los cuarenta reportes; pero con una computadora y Word implica que es hora de aprender a hacer fusión de documentos (“merge”).

Estos son los pasos que seguiremos en el taller:

1. Crearemos un documento con una tabla que contendrá los nombres y notas de los estudiantes.  Este documento será nuestra base de datos.
2. Crearemos en otro documento un reporte genérico que usara los datos de la tabla que crearemos en el anterior para generar TODOS los reportes.

3. Generaremos, con solo un clic, un tercer documento que contendrá todos los reportes.

Empecemos.

Parte 1: Crear la base de datos

En un documento nuevo construya una tabla de once filas y siete columnas.

La primera fila de la tabla contendrá los encabezados que servirán como el nombre de los campos de información para los reportes.

	NOMBRE
	ESPA
	ING
	MATE
	ARTE
	BIOL
	HIST

	
	
	
	
	
	
	

	
	
	
	
	
	
	

	
	
	
	
	
	
	

	
	
	
	
	
	
	

	
	
	
	
	
	
	

	
	
	
	
	
	
	

	
	
	
	
	
	
	

	
	
	
	
	
	
	

	
	
	
	
	
	
	

	
	
	
	
	
	
	


Parte 2: Crear el reporte genérico 

En un nuevo documento escriba el encabezado apropiado

Ejemplo
Escuela Sutana de Tal

Distrito de Macondo

REPORTE DE NOTAS

Ajuste tamaño y tipografía a su gusto.

Seleccione el menú Tools > Letters and Mailings > Mail Merge Wizard.

	 Luego aparece una caja de diálogo a la derecha, como la de la ilustración que está a la derecha, seleccione Letters y vaya al paso siguiente, seleccionando Next: Starting document
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	Aparece una ilustración como la de la izquierda y a continuación tenemos que seleccionar con el documento genérico con que trabajaremos. (How do you want to set up yours letters?) 

En este caso usaremos un nuevo documento (Use the current document). Y vamos al paso siguiente oprimiendo Next: Select de recipients)




Ya ubicado en Select de recipients selecciono la opción Type a new list, cuando selecciono esta opción entonces me aparece Create (como se presenta en la ilustración de más abajo 
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Luego selecciono Create y me aparece una caja de diálogo con el nombre de New Address list  Como la ilustración siguiente:
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En esta caja de diálogo selecciono la opción customize… 

Aparece otra caja de diálogo con el nombre Customize address list, entonces comience a borrar todos los campos, seleccionándolos y dándole un clic a delete. Luego de que todos los campos están borrados oprimo Add para agregar los nuevos campos, entonces aparece una caja de diálogo donde entro el nombre del campo y oprimo OK, así lo hago hasta introducir todos los campos, luego oprimo OK y Close.
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Luego coloco el cursor en la primera celda de la primera columna, voy al icono insert merge fields que está en la barra de herramientas de Mail Merge, a continuación selecciono el primer campo y lo agrego. Le doy un clic a Close y hago lo mismo hasta completar la tabla con todos los campos.
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A continuación selecciono el icono de  Mail Merge recipients, selecciono edit y comienzo a entrar los datos en los campos. Selecciono Close y luego OK.

[image: image28.bmp] Icono del Mail Merge recipients
Parte 3: Realizar la fusión

Selecciono el icono Merge to new document de la barra de herramientas de Mail Merge, selecciono OK  y aparecerá el nuevo reporte.
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